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Introduction	to	ImageQuest	

Welcome to ImageQuest! 
The ImageQuest product line is a complete enterprise content management system consisting of 

document/file management, forms processing and workflow components.  ImageQuest is designed to 

facilitate access to and the distribution of document-oriented information within your organization.  By 

putting documents at your fingertips and leveraging the related data, ImageQuest will improve 

efficiency while helping you deliver better service. 

Informa Software has a strong commitment to customer service and product quality.  If you have 

questions, please contact an Informa Client Services Representative immediately.  Thanks for using 

ImageQuest and please share your ideas on how we can make ImageQuest better for everyone. 

Please contact us below for technical support and/or troubleshooting: 

ImageQuest Support 

(877) 475-7778 

support@informasoftware.com 

http://www.informasoftware.com/support  
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Requirements 

Server Requirements 

• P4 CPU or higher (multi-core recommended) 

• 2GB Memory (4GB Recommended) 

• DVD Drive (if installing from disc) 

• 300MB free hard drive space (for program files only) 

• Windows Server 2003 R2 SP2, Windows Server 2008 SP2, Windows Server 2008 R2, Windows XP 

SP3, Windows Vista SP2, or Windows 7.  (32-bit and 64-bit OS versions are supported, but 

ImageQuest runs in 32-bit mode on a 64-bit OS) 

• If a software firewall product is running on the server, please ensure that TCP ports 32751 and 

33176 and UDP port 2112 are open. 

• Microsoft .NET Framework version 4.0 (Full Framework) 

• Microsoft SQL Server 2005 or 2008 is required to install ImageQuest.  If you do not already have 

a SQL server, SQL server 2008 R2 Express is included on the installation media. 

• Internet Information Service (IIS) Server is required to configure WebIQ 

• IIS must be installed and configured to install OXPd on an HP device which does not natively 

support OXPd. 

Client Requirements 

• P4 CPU or higher (multi-core CPU recommended) 

• 80MB free hard drive space (for program files only) 

• Microsoft .Net Framework version 4.0 (Client Profile) 

• Local administrative access is required to perform the initial client installation. 

• Windows XP SP3, Windows Vista SP2, or Windows 7.  (32-bit and 64-bit OS versions are 

supported, but ImageQuest 10.3 runs in 32-bit mode on a 64-bit OS) 

• Adobe Acrobat Reader 6.0 or higher 

• Microsoft Office 2003, 2007 or 2010 (x86 only) is required for the ImageQuest Office Connector 

• WebIQ Clients require Internet Explorer 7 or higher 

OXPd Requirements (Required for HP MFP Integration) 

• ImageQuest version 11.0 must be installed 

• Supported HP device with the latest firmware 

• IIS must be installed on the ImageQuest ServerInstallation 
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Installation Notes 

• ImageQuest 11.0 only supports upgrading from at least version 10.3.  If you are running an older 

version, you must first upgrade to 10.3 before moving to 11.0. 

• It is recommended that you backup your existing ImageQuest images folder and SQL database 

prior to performing an upgrade.  

• The IQ Application Service must be "Started" before performing an upgrade. 

• ImageQuest client machines must be upgraded to 11.0 after a server upgrade. 

• SQL server is no longer installed by the ImageQuest installer.  There is an option in the Autorun 

program on the installation media to install SQL 2008 R2 Express if it's required. 

Server Installation 
To install or upgrade the ImageQuest server, run the autorun.exe program from the installation media.  

The autorun menu has several different installation options: 

• Install/Upgrade ImageQuest 10.3 to ImageQuest 11.0 using an existing SQL server in the 

organization 

• Install ImageQuest 11.0 and SQL 2008 R2 Express x86 edition 

• Install ImageQuest 11.0 and SQL 2008 R2 Express x64 edition 

 

These options can all be found under the “Install ImageQuest…” button on the autorun home screen.  If 

you opt to have the autorun install SQL 2008 R2 Express for you, please make sure the following 

prerequisites are installed prior to beginning the installation: 

• Windows Installer 4.5 

• Windows Powershell  

• Microsoft .NET Framework 3.5 

 

The prerequisites are also included on the installation media under the “Prerequisites…” button on the 

autorun home screen.  

For advanced users, the prerequisites button also includes an option to install SQL 2008 R2 Express 

server separately.  This is the standalone SQL installer and needs to be setup manually.  If you choose to 

install SQL this way, please make sure to include the Full-Text Search option during the installation.  Also 

make sure that the SQL Full-text Filter Daemon Launcher service is started before proceeding to the 

ImageQuest server installation.  

Note:  Microsoft SQL Server 2008 R2 Express Edition is limited to using 1 processor, 1GB of RAM and a 

10GB Database. 

Alternatively, you may run the server.msi program in the root of the installation media which will work 

for both new installs and for 10.3 upgrades. 
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Upgrading to 11.0 
Version 11.0 can only upgrade from ImageQuest version 10.3.  If you are running 10.2 or older, you will 

first need to upgrade to ImageQuest 10.3 before applying the 11.0 update.  Please contact Informa 

Software support for assistance with obtaining an older version of the software. 

To upgrade to version 11.0, click the “Install ImageQuest…” > “Install/Upgrade” buttons from the 

autorun program or run the server.msi file from the root of the installation media.  The installation 

program will automatically detect that you are upgrading from an older version and will upgrade all of 

the ImageQuest cabinets listed in the Warehouse. 

Client Installation 
To install or upgrade the ImageQuest client run the client.msi program from the installation media.  The 

client.msi file can also be found on the ImageQuest server in a file folder called ClientSetup. 

Silent Client Installations 
The command line options for silent installs have changed since the previous versions.  Please refer to 

the following example when configuring a silent installation scenario: 

Msiexec /i client.msi /quiet 

ADDLOCAL=IQDesktopFeature,IQAdminFeature,IQnotifyFeature,OfficeConnectorFeature,ExplorerConne

ctorFeature,IQPrinterFeature. 
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IQadministrator 

Manage Warehouse 
To access IQadministrator after the server installation, go to Start > All Programs > Informa Software > 

ImageQuest > IQadministrator and enter the Administrator password.  If this is the first time running 

IQadministrator, you will be prompted to create the password.  Click “Login” as illustrated below. 

                                               

The main IQadministrator screen will open as shown below.  Go to the “File” menu and click “Manage 

Warehouse”. 
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The following features may be accessed from the “Manage Warehouse” window:  Manage Users, 

Manage Licenses, SMTP Server and the Cabinet List as displayed below.   

 

 

Manage Users 

Anyone who will need to access ImageQuest will need to be added as a user in the IQadministrator. 

Users can be managed at the Warehouse and the Cabinet levels.  The Warehouse manages all users of 

the system, and their Cabinet memberships.  New users can be created at the Warehouse level, and 

then added to a Cabinet; or a user can be created at the Cabinet level, and will automatically be added 

to the Warehouse.  See below. 

 

 

If a user is removed from a Cabinet, that user is still a member of the Warehouse.  If a user is deleted 

from the Warehouse, that user is permanently deleted and removed from all Cabinets. 
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Manage Users allows the Administrator to change user passwords, login options and Cabinet access.  

The screen on the next page shows a list of established Warehouse. 

 

       

Note:  The Administrator User is created by default with cabinet access and can be modified but 

cannot be deleted. 
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Adding New Users 

To add a new user to the Warehouse, select Manage Users in the “Manage Warehouse” window. 

Enter the name of the user in the “Username” field and the Domain in the “Domain Name” field.  When 

creating a new user, click the checkbox to “Allow this user to authenticate with their Active Directory 

credentials”; if you wish to assign the user Single-Sign On (SSO).  See the Single Sign-On (SSO) Overview 

on page 9 for more information.  Click “Add User” at the bottom right to finish adding the new user. 
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See below for information about user options. 

 

New User Information Definition 

Username The name of a user assigned in the cabinet 

(i.e. “jsmith,” “dogden”) 

First Name 

 

The first name of the user 

Last Name 

 

The last name of the user 

Password An access code assigned to or established by 

a user (i.e. case sensitive, and a combination 

of letters and numbers). 

Confirm Password 

 

Verify the created password. 

Allow the user to authenticate with their 

Active Directory credentials 

 

Activates Single Sign-On (SSO) for a user 

which does NOT require a password. 

Domain Name Enter the network’s NETBIOS domain name 

 

Email Address Enter the user’s email address for routing 

notifications (i.e.  jsmith@usacompany.com) 

Send email notifications to this user Activates document routing notification per 

user through ImageQuest. 

 

 

Note:  Routing notifications require further mail configuration. 
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Single Sign-On (SSO) Overview 

ImageQuest gives the Administrator the option of allowing users to authenticate with their Active 

Directory credentials using Single Sign-On (SSO).  

When a user logs into their workstation using their domain account, and they have appropriate 

permissions, they can access the ImageQuest client programs without providing a password.  

If SSO is not selected for a user, the user will need to provide a username and a password (optional) as 

determined by the Administrator to login to each ImageQuest application; this allows a user to login as a 

user that is different than the user account used to login to the client workstation and it also 

accommodates networks without a domain controller. 

Note:  If the user will authenticate with their Active Directory credentials, the Username must match 

the user’s Active Directory login name.  SSO is selected by default.  Uncheck the checkbox for Active 

Directory credentials to deactivate SSO for a user and specify a password for the user instead; blank 

passwords are also allowed for non-SSO users. 

The new user is now listed under Warehouse Users along with the new user’s SSO status and the 

Cabinet assignment as displayed below.  Once a user is created, you may manage user information by 

highlighting a Username and clicking “Properties”. 

 

 

                                                

 

 

 

 



  ImageQuest Administrator’s Guide 11.0 

16 

 

Manage User Information 

The Administrator can add or change user information and add or remove cabinet access if required.  

See the example below.   

                                                       

Deleting a User 

To delete a user from the Warehouse and from all Cabinets, highlight the username and click “Delete”.  

Deleting a user from the Warehouse cannot be undone; this function will permanently delete the user 

and remove the user from all Cabinet assignments, role membership, permissions and the Watch List 

entries.  You will be prompted with the message as illustrated below to confirm the user you intend to 

delete.  

                                         

Note:  A user can be added or removed from a cabinet, but still appear as a user in the warehouse.  If 

the user is removed from a cabinet, he or she will no longer have access rights to the cabinet, and will 

not appear as a cabinet user. 
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Manage Licenses 

The ImageQuest Warehouse accommodates multiple license keys.  To view and manage license 

information in the Warehouse, click Manage Licenses.  The “License Status” tab displays information on 

your installations.  When ImageQuest is first installed, there is a 15-day trial period for all modules.  If 

you have requested and received an extended trial license key from Informa Software Support, click 

“Extend Trial” and enter the extension key.  See screenshot below. 

 

 

 

Note:  The “Extend Trial” feature is only available on the ImageQuest server machine, not on the 

ImageQuest client machine. 

To request a license key from Informa Software Support, you will need to email the Server ID, any 

current license keys and the serial number(s) of any HP MFP devices that will be applied to 

support@informasoftware.com.  See below. Click on the “License Keys” tab in the Manage Licenses 

screen.  The Server ID is located in the top, right corner of this screen, and may be copied and pasted 

into the email to Informa Software Support.  
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Once the license key code is received, copy the key code and paste it into the “Enter a new license key” 

field as highlighted below and click “Add”.   

Click the “+” and “-“ boxes to expand or collapse the list of features in the Warehouse that are licensed.  

In the screenshot below, “dogden” has entered two license keys, one entered on March 19, 2008 and 

the other on June 9, 2008.  “Entered by” reflects which Windows user added the key. 

 

Note:  To delete a license key, click the  next to the license key to be deleted. 
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SMTP Server 
The SMTP Server menu allows the administrator to configure the SMTP Server Settings for ImageQuest 

email routing notifications and send a test email to confirm the settings are valid. 

This SMTP Server feature is available in IQadministrator under File > Manage Warehouse and has been 

removed from the web.config file where it was previously configured.  The password is also now stored 

in the ImageQuest database and is also encrypted.  
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Cabinet List 
The Cabinet List displays the current ImageQuest Cabinet information.  To access the Cabinet List 

window, click Cabinet List in the “Manage Warehouse” menu as shown below. 
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Manage	ImageQuest	

Manage ImageQuest allows the administrator to add and configure cabinet users, document types, 

document groups and HP MFP devices.  They can also create queries for frequently used IQ searches, 

manage the IQ file storage location and configure folders for use with IQfolder. 

To return to Cabinet Management from the Warehouse, click the drop-down arrow next to “Select 

Cabinet” and choose ImageQuest or the Cabinet name from the list as shown below.   

 

Manage Users and Roles 

To add a new user in the ImageQuest Cabinet, select Manage Users and Roles as shown below. 
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Any users that have been added through the Warehouse and are members of the ImageQuest Cabinet 

will be listed in Cabinet Users as displayed on the next page. 

Note:  When a new user is created in the Cabinet, the new user is also created at the Warehouse level. 

 

Click “Add” as shown above to add a new user to the Cabinet.  An existing user can be chosen from the 

Warehouse list or a new user can be created at this time.   

To create a new user, enter the name of a user in the “Username” field and the First Name/Last Name 

fields as illustrated on the following page. Click “Next” to manage user permission and role 

memberships.  Select “Done” to finish creating the new user. 
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Review New User Information on Page 14 before entering new user information in the fields shown 

below. 

 

                                                         

Note:  If the user will authenticate with their Active Directory credentials, the Username must match 

the user’s Active Directory login name.  SSO is selected by default.  Uncheck the checkbox for Active 

Directory credentials to deactivate SSO for a user and specify a password for the user instead; blank 

passwords are also allowed for non-SSO users. 
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New User Properties and Permissions 

ImageQuest features the following action permissions for users and roles: 

Action Permission Description 

Add Document Allows a user to add documents to the Cabinet through any IQ 

client application.   

Annotate Document Image Allows a user to add annotations to a PDF document from 

IQdesktop. 

Delete Batch Allows the user to delete a batch from the “Indexing Queue.”   

 

Delete Document 

 

Allows a user to delete or undelete a document from IQdesktop.   

Manage Document Type Allows a user to add, remove and/or edit Document Types and 

Attributes.  This permission is also required to add “List-based” 

attribute items on the fly. 

 

Update Document 

 

Allows a user to add document revisions and to edit document 

attribute values.   

View Deleted Documents Allows a user to view deleted documents. 

 

View Only Disables documents from launching in their native program and 

loads the documents in a Read-Only viewer.   

View Prior Revisions Gives users the ability to view older versions of a document by 

right-clicking the revision in the history pane and selecting “View 

Revision”.   
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Once a new user is created, the new user’s “Action Permissions” are “Not Set” by default as highlighted. 

 

 

 

Before setting permissions, see the chart on the next page to distinguish between “Not Set,” “Allow” 

and “Deny”. 

Permission Assignment Description 

Not Set 

 

Permission is neither allowed nor denied.   

Allow Gives users and roles access to action permissions and 

document types. 

Deny Explicitly blocks users and roles access to action permissions 

and document types. 

                 

Permissions can be set for each user as demonstrated below by right-clicking to select the assignment or 

by left-clicking to activate the assignment drop-down as shown on the next page.   

Note:  The Administrator user’s Action Permissions are all set to “Allow” by default. 
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Note:  Permissions can also be set at the role level.  To add roles and assign users, see “Adding New 

Roles”.  See the effective permissions above representing the user’s combined user/role permissions. 
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In the example highlighted on the next page, notice that “dogden” is granted permission to “Add 

Document” and “Annotate Document Image,” but is denied permission to “Delete Batch” and “Delete 

Document”.  At the same time, the permissions for “dogden” to “Manage Document Type” and to 

“Update Document” are “Not Set”.   

 

                    

To assign “Action Permissions,” see the permission grid for effective permissions below to effectively 

manage user and role permissions in the Cabinet. 

User Permission Role Permission Effective Permission 

Not Set Not Set Not Set 

Not Set Allow Allow 

Not Set Deny Deny 

Allow Not Set Allow 

Allow Deny Deny 

Allow Allow Allow 

Deny Not Set Deny 

Deny Allow Deny 

Deny Deny Deny 
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To set the “Document Permissions” for “dogden,” for example, click the “Document Permissions” tab.  

The user “dogden” will only have permissions to document types allowed to him or her.  In the 

screenshot on the following page, the “Document Permissions” are “Not Set”.  Right-click on the 

permission(s) to select the assignment or left-click it to activate the assignment drop-down. 
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When assigning “Document Permissions,” be sure to see below to effectively manage user and role 

permissions in the cabinet. 

Note:  “Allow by Default” below refers to an option in Manage Document Types.  See pg. 32 for more 

information.  

User Permission Role Permission Allow By Default Effective Permission 

Not Set Not Set Not Set Not Set 

Not Set Not Set Allow Allow 

Not Set Allow Not Set Allow 

Not Set Allow Allow Allow 

Not Set Deny Not Set Deny 

Not Set Deny Allow Deny 

Allow Not Set Not Set Allow 

Allow Not Set Allow Allow 

Allow Deny Not Set Deny 

Allow Deny Allow Deny 

Allow Allow Not Set Allow 

Allow Allow Allow Allow 

Deny Not Set Not Set Deny 

Deny Not Set Allow Deny 

Deny Allow Not Set Deny 

Deny Allow Allow Deny 

Deny Deny Not Set Deny 

Deny Deny Allow Deny 
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Membership 

Roles must first be created in order for them to appear in the “Membership” tab; manage role 

membership on the “Membership” tab.  To assign or remove role membership for a user, check the 

checkbox.  As show below, “Bjones” is assigned to the “Sales” role membership only.  Click “Done” to 

complete.   

 

 

Note:  Membership in one or more roles can change the effective permissions for a user.  Each list at 

the bottom of the “Action Permissions” and the “Document Permissions” tabs represent the User’s 

effective action permissions.   
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Adding New Roles 

When ImageQuest is first configured, the Administrator can add roles as a way to save time in assigning 

“Action Permissions” and “Document Permissions”.  Cabinet users can be assigned to multiple roles; 

roles can also be created without document permissions for the purpose of controlling access to specific 

ImageQuest devices.   

Creating a role for each department in your work environment may be valuable because individual 

departments usually handle different types of documents.  For example, employees in the Sales 

Department may not need to find an Invoice from the power company, but the Accounting Department 

would.  Alternatively, the Accounting Department will not be looking for Sales Brochures filed by the 

Sales Department.  By creating an “Accounting” role and a “Sales Department” role, documents and 

permissions can be managed quickly within the IQadministrator. 

To add a new role, click Manage Users and Roles as shown in below.  The window displays “Cabinet 

Users” at the top and “Roles” at the bottom.  Locate “Roles” and click “Add”. 
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For example, to create a role for the Sales Department, enter “Sales” in the “Create a new role” window 

as illustrated on the next page and click “Next”. 
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Set action and document type permissions for the “Sales” role as shown below and on the following 

page; click “Done” when finished.  
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Click the “Membership” tab to assign or remove user membership for the indicated role as displayed 

below.  Notice that “Administrator,” “Jsmith” and “Bjones” are all assigned to the Sales role 

membership. 

 

 

 

Membership in one or more roles can change the effective permissions for a user; for example, see the 

bottom portion of the “Action Permissions” and the “Document Permissions” tabs on the following page  

representing the user’s effective action and document type permissions for “Jsmith”.   
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  ImageQuest Administrator’s Guide 11.0 

37 

 

Removing Users or Roles 

Users and roles can be removed from the Cabinet in Manage Users and Roles by clicking the “Remove” 

button as illustrated below. 

 

 

                          

                         

Note:  If a user is removed from the cabinet, the user is NOT deleted from the Warehouse.  If a role is 

removed from the cabinet, the user members who were assigned to that role are NOT removed from 

the cabinet. 
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Manage Document Types 
Now that you have established users and roles and have set permissions and assignments, you are ready 

to manage document types in ImageQuest.  Click Manage Document Types in the cabinet as displayed 

below.  This window contains the “Document Types” and “Attributes” tabs; the window defaults to the 

“Document Types” tab each time it is opened.   

 

 

                                                                   

Note:  The MFP Scan document type and attributes—MfpInputUser, MfpAddress, MfpDisplayName, 

MfpHostName and MfpSerial—are created by default and can neither be deleted nor edited. 

Document Type Overview 

Document types that will be utilized by your company have to be created in ImageQuest; there should 

be a “Document Type” created for every document that your company uses frequently, or is currently 

filed on a regular basis.  It may be helpful to record a list of all the documents your office currently uses, 

who is permitted to use the document and how and from which departments the documents are 

originated.  For instance, if your company wants to store HR type documents in IQ, you may create 

document types such as “W-4”, “I-9” or “Performance Evaluation”. 

Attribute Overview 

Attributes are index fields that allow users to search for filed documents.  There are no restrictions on 

how many or few attributes can be added per document type.  Adding too many attributes may slow 

down the indexing process considerably while adding too few could make the documents harder to find.    

In the sample on the following page, the Manage Document Types window displays the “Attributes” 

tab.  The default MFP Scan attributes are listed—MfpAddress, MfpDisplayName, MfpHostName, 

MfpInputUser and MfpSerial; new attributes may be added and edited using the “Add New Attribute” 

and “Edit Attribute” buttons. 
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Note:  Attributes may be created, edited and deleted from the “Attributes” tab.   

Creating a New Document Type 

Once you have compiled your office’s list of documents, create a new Document Type for each.   

In Manage Document Types, click the “Document Types” tab to add a Document Type as illustrated 

below.  Click “Add” to show the “Add New Document Type” dialog box.  

 

 

                                                   

Enter the name of the document as demonstrated on the following page.  Below the name field, the 

Administrator may click the checkbox “Allow users access to this document type by default” only if it is 

desired for all users to have access to the Document Type.  Click “OK” to save the new Document Type. 
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The screenshot below shows that the new document type, “Invoice,” has been created and is added to 

the “Document Types” tab in alphabetical order; the checkbox to the right of the tab is checked to allow 

users access. 
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Creating and Assigning New Attributes 

Once a document type is created, it will need to be assigned “Attributes” (index fields).  Click “Add New 

Attribute” as highlighted below. 

 

 

The screenshot below shows the “Add New Attribute” window and the options for attribute 

configuration.  See the table on the following page for a description of each section. 
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Section Description 

Attribute Name 

 

The name of the attribute 

Data Type The type of input associated with the attribute 

 

Description 

 

A brief explanation of a data type with specific examples 

Options 

 

  Minimum (length or value)  

 

  Maximum (length or value) 

   

  Default 

 

  Required 

 

  Include in filename 

 

 

  Input Mask 

 

 

 

Minimum number of characters or minimum value allowed 

 

Maximum number of characters or maximum value allowed 

 

A pre-fill value for indexing 

 

Attribute value must be populated when indexing 

 

Includes the attribute value as part of the file name when using the 

“Save Local Copy” and “Email Document”  features of IQdesktop 

 

Provides restricted data input 

Test Area 

 

Allows testing of data input for a data type  
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There are six data types that can be assigned to attributes.  The attribute data type selected will control 

the type of information entered into a field of that type.  Reference each attribute data type and 

description in the table on the following page before you assign the data type to each new attribute you 

create.  Once a new attribute is saved, the data type for it cannot be changed. 

 

Attribute Data Type Description 

Text Any keyboard character may be entered such as letters, numbers, punctuation, 

alpha-numeric account numbers and/or any numbers that begin with leading 

zeros (i.e. 003-RBC0908; 123-456-7890; (407) 555-1212; 007). 

 

Numeric Stores fractional values for currency amounts or percentages.  Numeric values 

can have up to 29 total digits with at most 8 digits to the right of the decimal 

place (i.e. 3.50; 3.14159). 

 

List Creates a drop-down list of choices that you define (i.e. a list of customers, a list 

of cities, a list of companies, etc.).  Users may add “List-based” attribute items 

on the fly if they have the “Allow” Manage Document Type permission. 

Note:  A list-based attribute is preferred whenever possible in order to 

minimize indexing errors. 

Integer Requires whole numbers with no punctuation, no decimal, and with no leading 

zeros.  Integer values have an absolute maximum of 2147483647 and an 

absolute minimum of -2147483648 (i.e. 1138; 2112). 

 

Date & Time Stores dates and can default to the current date.  Date & Time attributes have a 

maximum of 12/31/9999 11:59:59 PM and an absolute minimum of 1/1/1753 

12:00:00 AM (i.e. 1/1/1970; 6/10/2008). 

 

True/False Attributes can be true, false or non-existent (null), typically displayed in the form 

of a three state checkbox, either checked, unchecked or grayed out for true, 

false or non-existent respectively.    
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The “List” attribute data type screen is a bit different from the other data types.  In the screenshot 

below, the “List” data type has been selected for the new attribute name, “Status”.   

 

 

                                                                        

Once this data type is selected, the “Options” section changes as illustrated below.  List-based attributes 

allow you to select an item from a list of choices you define such as the example displayed.  By default 

each list item is enabled.  Deselecting this checkbox will remove that item from the list shown during 

indexing but will leave it available for searching previously indexed documents. 

 

                                   

Note:  The test area does NOT apply to the “List” and “True/False” data types. 
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The first Attribute Name assigned to the document type, “Invoice,” is “Patient Name”.  This attribute is 

categorized as a “Text” data type; its description is displayed to the right for review.  Jane Doe is tested 

for accuracy in the test area field; the test results show that this data input Passed for this Data type.  

Click “OK” to save and assign the new attribute to the selected Document Type and add the new 

attribute in the “Attributes” tab.  See the following page.  Once an attribute is added, it can then be 

assigned to other Document Types as needed. 

 

 

                              

Note:  “Text” fields are the most flexible data types.  Even if the value of the attribute is a number 

such as a Social Security number, the “Text” data type may be the best choice because it allows 

dashes, leading zeros and specific lengths. 
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Note:  The “Add New Attribute” button in the “Attributes” tab only creates the attribute and does 

NOT assign it to any particular document type. 
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Input Masks 

Input Masks provide restricted data input as well as formatted data output. Masks can be used to 

ensure that end-users enter values only in a particular format.  For instance, when indexing a phone 

number, an end-user needs to enter only digits, while hyphens and parentheses should be automatically 

skipped. 

Manage Document Types now includes several pre-defined attribute masks for the following 

ImageQuest Attribute Data Types:  Text, Numeric and Date & Time. 

The pre-defined input masks for Text are “US Phone Number” and “Social Security Number”.   

The pre-defined input mask for Numeric is “Currency”. 

The pre-defined input masks for Date & Time are “Date Only” and “Date with Time”. 

In the example below, the administrator creates a new Attribute called “Phone Number”, selects “Text” 

for the Data Type and “US Phone Number” from the Input Mask drop-down. 
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The administrator then presses the tab key to move to “Test Area”.  Note that the US Phone Number 

Input Mask is applied. 
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The administrator enters a test value “8774757778” and clicks “Test” to confirm the input passes 

validation.  There is no need to enter the parentheses and hyphen characters as the mask provides them 

automatically.  Also note that this type of mask only allows 10 numeric digits to be typed.  All other 

keyboard characters will be ignored. 
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Click “OK” to save the attribute and add it to the main Attributes list.  

The administrator can also create custom input masks for the Text, Integer and Numeric Data Types. 

For example, perhaps an Invoice Number always begins with “INV-“ and is followed by 5 digits.  The 

administrator wants to add an Attribute with an input mask that will automatically display the “INV-“ 

prefix and enforce the number of digits that can follow. 

The administrator clicks “Add New Attribute”, enters “Invoice Number” for Attribute Name and selects 

Data Type “Text”.   

For Input Mask, the administrator enters “INV-00000” and presses the Tab key.  The input mask is 

displayed in the Test Area as “INV-     “. 
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The administrator enters the value “12345” and clicks “Test” to confirm the input passes validation.  

Once again, the user will only need to type in the five digits as the “INV-“ will always be prefilled and 

cannot be deleted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click “OK” to save the attribute and add it to the main Attributes list and the input mask will be 

displayed in the Input Mask column. 

In addition to the predefined input masks that are provided, the administrator has the option to create 

custom input masks.  See the tables on the following pages for descriptions and samples on how to do 

this. 

Note:  Input Masks are not supported in WebIQ.   
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Custom Input Masks (Text) 

 

Metacharacters  

Metacharacters are used to represent a range of symbols. An end-user can enter text only in the 

positions which correspond to metacharacters.  When a metacharacter is found at a specific position in 

the mask an end-user can enter any character from the related range in this position in the edit box.  

The following table lists the available metacharacters:  

 

Character Meaning 

L  An L character requires an alphabetic character in this position. For the U.S. this is A-Z, a-z.  

l  An l character permits only an alphabetic character in this position, but doesn't require it.  

A  An A character requires an alphanumeric character in this position. For the U.S. this is A-Z, a-z, 0-9.  

a  An a character permits only an alphanumeric character in this position, but doesn't require it.  

C  A C character requires an arbitrary character in this position.  

c  A c character permits an arbitrary character in this position, but doesn't require it.  

0  A 0 character requires a numeric character in this position.  

9  A 9 character permits only a numeric character in this position, but doesn't require it.  

#  A # character permits only a numeric character or a plus or minus sign in this position, but doesn't require it. 
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Special Characters  

The following table lists the available special characters which are used to control the case of the input 

string and to represent various delimiters and currency symbols.  

 

Character Meaning 

>  If a > character appears in the mask, all the characters that follow it are in uppercase until the end of the mask 

or until a < character is encountered.  

<  If a < character appears in the mask, all the characters that follow it are in lowercase until the end of the mask 

or until a > character is encountered.  

<>  If these two characters appear together in a mask, no case checking is performed and the data is formatted 

with the case used by the end-user during data entry.  

 

 

/  A / character is used to separate the months, days, and years in dates.  If the character that separates the 

months, days, and years is different in the regional settings of the system that the application runs on that 

character will be used instead.  

:  A : character is used to separate the hours, minutes, and seconds in time values.  If the character that 

separates the hours, minutes, and seconds is different in the regional settings of the system that the 

application runs on that character will be used instead.  

$  A $ character is used to designate currency values.  If the character that designates the currency values is 

different in the regional settings of the system that the application runs on that character is used instead.  

 

Literal Characters  

A character that is neither a metacharacter nor a special character is called a literal.  Literals are inserted 

automatically as is into the edit box in their positions defined by the mask.  An end-user has no need to 

enter literal characters.  The cursor skips over them during editing.  

The metacharacters and special characters can also appear as literal characters if they are preceded by a 

backslash (\).  
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Examples  

 

1. A mask for entering a telephone number:  (000)000-00-00.  

Each '0' metacharacter in this mask requires a numeric character in the corresponding position.  No 

characters can be omitted. The '-', '(' and ')'characters in the mask are literals.  

The following are images of an editor that uses this mask:  

 (a value is not entered)  

 (a value is entered)  

2. A mask for entering a telephone number with an optional area code:  (999)000-00-00  

Here the '9' metacharacter allows end-users to omit the area code part of a phone number.  

 (a valid phone number without a code part)  

3. A mask for entering an alpha-numeric sequence:  \A>LL-00  

Here '\A' stands for the literal character 'A'. Since 'A' is used as a metacharacter the backslash must be 

used to make 'A' appear as a literal. The '>' command specifies that the following text should be in 

uppercase. The 'LL' substring indicates that two alphabetical characters should be inserted in this 

position. The '00' substring is a placeholder for two digits.  

 (a value is not entered)  

 (a value is entered)  

Note:  When a text input mask is enabled, any new attributes that are indexed will store the mask 

characters along with the data.  Historical data that has already been indexed before the mask was 

created will have the mask applied when displaying the fields but the underlying data will remain 

unchanged. 
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Custom Input Masks (Numeric/Integer) 

Numeric input masks are specifically designed for entering numeric values (integer, float values, 

currencies, percents, etc.).  Specific numeric masks are dependent upon the current culture (regional) 

settings. 

Input masks allow end-users to edit numeric values of common numeric types . A standard mask 

represents a string of the Axx form where A is a single alphabetic character (mask specifier), and xx is an 

optional integer called the precision specifier.  The available mask specifiers are listed in the following 

tables.  The precision specifier ranges from 0 to 99 and controls the number of significant digits or zeros 

to the right of the decimal point. 

 

Input Mask 

Character 
Name Description 

Samples 

Culture: English (USA) 

C or c Currency The mask for entering a currency amount. The input mask 

contains a value part which can be edited by an end-user, 

and a currency symbol which cannot be edited.  The 

mask's format is determined by the current culture.  

The precision specifier indicates the desired number of 

decimal places. If the precision specifier is omitted, the 

precision will be set to 2. 

(EditMask = "c"; EditValue = 

1024.5)  

(EditMask = "c0"; EditValue = 

20010)  

D or d Decimal The mask for entering integer values of a fixed and 

flexible length.  

The precision specifier indicates the maximum number of 

digits that can be entered.  If the precision specifier is 

equal to 0 or omitted, the length of the input string is not 

limited.  

If the editor's value is real, the fractional part of the value 

will be discarded during editing.  

(EditMask = "d"; EditValue = 

1501)  

F or f  

G or g 

Fixed-point The mask for entering real numbers with a fixed-length 

fractional part.  

The precision specifier indicates the desired number of 

decimal places.  If the precision specifier is omitted, the 

precision will be set to 2.  

(EditMask = "f"; EditValue = 

1024.5)  
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N or n Number The mask for entering the integers of real values. 

Thousand separators are inserted between each group of 

three digits to the left of the decimal point.  

The precision specifier indicates the desired number of 

decimal places.  If the precision specifier is omitted, the 

precision will be set to 2. 

(EditMask = "n"; EditValue = 

1024.5)  

P Percent 

(mode 1) 

The mask for entering percents. The entered string is 

converted into a number "as is" (compare with the 'p' 

mask).  So, if the "15 %" string is entered, the editor's 

value will be 15.  

The precision specifier indicates the desired number of 

decimal places.  If the precision specifier is omitted, the 

precision will be set to 2. 

(EditMask = "P"; EditValue = 

25)  

p Percent 

(mode 2) 

The mask for entering percents. The entered string is 

converted to a number and then divided by 100. The 

result is used as the editor's value (compare with the 'P' 

mask).  So, if the "15 %" string is entered the editor's 

value will be 0.15.  

The precision specifier indicates the desired number of 

decimal places.  If the precision specifier is omitted, the 

precision will be set to 2. 

(EditMask = "p"; EditValue = 

0.25)  
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You can also use the following characters to create custom masks for editing numeric values.  

 

Character Name Description 

0 Zero 

placeholder 

A decimal digit (0-9) can be entered in the corresponding position. Empty placeholders are 

represented by '0' characters.  When the input string is converted to the editor's value, digits 

left empty are interpreted as zeros.  

# Digit 

placeholder 

A decimal digit (0-9) can be entered in the corresponding position or left empty.  Empty 

placeholders are not displayed.  When the input string is converted to the editor's value, 

digits left empty are not stored in the result.  

. Decimal point The first '.' character in the format string determines the location of the decimal separator in 

the formatted value.  The actual character used as the decimal separator is determined by the 

current culture (regional) settings. 

 

, Thousand 

separator  

If the ',' character appears in the mask, thousand separators will be inserted between each 

group of digits to the left of the decimal point as defined by the culture (regional) settings.  

% Percentage 

placeholder 

If the '%' character appears in the mask, the value entered is divided by 100 when converted 

to the editor's value.  So, if the '15 %' string is entered, the stored value will be '0.15'.  

The percent character used is dependent upon the current culture.  An appropriate symbol is 

inserted in the edit box at the location where the '%' symbol appears in the mask.  

%% Percentage 

placeholder 

If the '%%' string appears in the mask, the entered value is not divided by 100 when it's 

converted to the editor's value. So, if the '15 %' string is entered, the edit value will be '15'.  

The percent character used is dependent upon the current culture.  An appropriate symbol is 

inserted in the edit box at the location where the '%' symbol appears in the mask.  

\ Escape 

character 

The character following the escape character is inserted into the edit box literally.  To display 

a backslash in the edit box the mask should contain the '\\' string.  

; Section 

separator 

The ';' character is used to separate the masks for positive and negative values.  

The mask can contain two parts delimited by the ';' character.  The first part defines the mask 

for entering positive values; the second part specifies a mask for entering negative values. An 

end-user can toggle the value's sign by pressing the '-' key. In this case, depending upon the 

value's sign, the value entered is automatically re-formatted using the appropriate mask.  

If the ";" character is followed by an empty string, the editor will not allow end-users to enter 

negative values.  
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$ Currency 

character 

Defines the position of the currency symbol determined by the current culture. 

Any other 

character 

Literal 

character 

Any other characters that appear in the mask are inserted into the edit box literally.  

To display special characters in the edit box literally, they should be preceded with the escape 

character ('\').  

 

Note:  If an editor's edit value is of the integer type, the editor only accepts integer values.  An end-

user will not be able to enter a fractional part of a number, even if it's allowed by the editor's mask 

End-User Capabilities  

Numeric masks allow end-users to enter numeric values only. Text cannot be edited in this mask mode.  

• Pressing the '-' key changes the sign of the value being edited. The caret can be placed at any 

position within the edit box.  

 

• Pressing the Up-Arrow and Down-Arrow keys increments or decrements the digit to the left of 

the caret's position. If the entire text is selected, pressing these keys increments or decrements 

the digit to the left of the decimal point.  

 

• Scrolling the mouse wheel increments or decrements the digit to the left of the caret's position. If 

the entire text is selected, scrolling the mouse wheel increments or decrements the digit to the 

left of the decimal point.  

Examples  

The following are examples of custom numeric masks. See the table in the Predefined Masks sub-section 

for examples of predefined masks.  

1. A mask for entering a real number which has a maximum of 4 digits to the left of the decimal 

point: #,##0.00  

Groups of three digits will be separated using thousand separators. The fractional part of the value will 

always contain two digits.  

 (Stored Value = 3080.6) 

 (Stored Value = -3080.6) 

2. The same mask for positive values. Negative values will be enclosed with double angle brackets: 

#,##0.00;<<#,##0.00>>  

 (Stored Value = -3080.6) 
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Note:  When a numeric\integer input mask is enabled, any new attributes that are indexed will NOT 

store the mask characters along with the data.  Historical data that has already been indexed before 

the mask was created will have the mask applied when displaying the fields but the underlying data 

will NOT remain unchanged.  

Category\Subcategory List Attribute Type 

The List attribute includes an option called Category\Subcategory.  If this option is enabled, list items will 

be shown in a hierarchical view where the subcategory changes based on the chosen category.  For this 

to function properly, category and subcategory items must be separated by the backslash (\) character. 
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In the example above, Category shows the entry to the left of the ‘\’ and the Subcategory shows what is 

to the right of the ‘\’. If this option is checked and entries are populated in the list options, users will be 

able to choose from a list of categories and subcategories like states\cities (i.e. New York\Albany). 
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Sharing Existing Attributes 

It may be beneficial for users to assign multiple attributes to each Document Type; this equips users to 

search for documents in ImageQuest more efficiently.   In the following example, we are creating a new 

document type called “Health History”.  The Administrator may check the box, “Show All Attributes,” to 

determine if any existing attributes apply to the new document type.  The screenshot below shows the 

existing attribute “Patient Name” is checked, assigning it to the “Health History” document type.  

 

 

Note:  When creating a new document type, any existing attribute that is associated with at least 80% 

of existing document types will automatically be selected for assignment to the new document type.  

Choose "Show All Attributes" to view all of the existing attributes defined in the system, and use the 

check boxes next to each attribute to select if that attribute is assigned to the document type. 
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Existing attributes can also be assigned from the document types tab by highlighting a document type, 

clicking the drop down arrow, highlighting an attribute and clicking the “Assign” button as illustrated 

below. 

 

 

Editing, Removing and Reordering Attributes  

There may come a time when attributes have to be renamed or removed from certain document types. 

In the Document Type, “Health History,” you will see the list of attributes to its right as illustrated below.  

The attribute, “Patient Name,” for example, needs to be renamed; the “Edit” attribute feature allows 

you to modify certain attribute options.  To edit the attribute, double-click it or highlight the attribute 

name, right-click on it and select “Edit” from the menu.   
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In the screenshot below, the original attribute name, “Patient Name,” is displayed.   

 

 

  

                                                                              

To rename this attribute, highlight the original name and type in the new name, “Patient Profile,” as 

shown below; click “OK”. 

 

 

                    

Note:  The option fields can be modified, but the data type cannot be modified. 

Now you will see the update in the attribute list for the Document Type “Health History” in the 

document types tab as shown on the following page.  
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Attributes can be unassigned or removed from Document Types.  For example, attribute “Patient Health 

Insurance Provider” is no longer needed for Document Type “Health History”.  Select the Document 

Type, right-click the attribute and select “Remove” from the menu.  See below. 

 

   

        

The dialogue box, “Confirmation,” below appears to ensure the Administrator wants to remove the 

selected attribute.  If so, click “Yes”.  The Document Type, “Health History,” will now have only one 

attribute: “Patient Profile”, for indexing. 
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Attributes can also be reordered for indexing purposes on the document type level.  By default, the 

attributes are displayed in the order in which they were assigned to the document type.  It may make 

more sense to have the attributes in a specific order, for example Street, City, State, and Zip.  If there is a 

need to reorder attributes, right-click an attribute and select “Move Up” or “Move Down” from the 

menu.  See the next page for an example. 

 

 

 

 

Editing and Removing Document Types 

To edit a Document Type, right-click the Document Type and select “Edit” in the menu as shown below.  

The “Modify Document Type” window will appear with the Document Type name highlighted.  For 

example, the Document Type “Health History” is being modified here.  Type in the new title, “Patient 

Health Record”, and optionally check the box to allow all users to access this Document Type by default.  

Click “OK”. 
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Once you click “OK”, you will see that “Health History” has been renamed to “Patient Health Record” as 

highlighted on the following page.  

 

                                                        

To delete a Document Type, locate it in the “Document Types” tab, right-click on it and select “Delete” 

in the menu as shown below.  The Document Type, “Invoice”, is being deleted. 

 

  

The dialogue box, “Confirmation” appears to ensure that the Administrator desires to delete the 

selected Document Type, “Invoice” as noted below.  Click “Yes”. 
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Note:  If a Document Type or Attribute is in use by one or more existing documents, they cannot be 

deleted.  This also includes documents that have been flagged as deleted. 

Manage Document Groups 
Document Groups allow the Administrator to organize documents and further restrict access to Users or 

Roles in addition to the permissions set at the Document Type level.  Once a Document Group is created 

and Users or Roles are added, only Users or Roles in that group can assign documents to the group or 

search and view documents assigned to the group. 

Click Manage Document Groups as displayed below to Add, Edit or Delete Document Groups. 

 

 

                                             

To create a new Document Group, click “New” to open the “Add Document Group” window as shown 

below.  The window contains the “Document Group Name” field and two lists, one for all current 

ImageQuest “Roles” and one for all current ImageQuest “Users”. 
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For example, a company receives invoices from three cities: Atlanta, Orlando and Phoenix. Each of these 

cities has a Sales Manager assigned to it. Only the Sales Manager and the company’s CFO are allowed 

access to the Invoice documents in the Cabinet for each location.  The Administrator can create a 

Document Group for each location and add the assigned Sales Manager and the CFO to the group to 

accommodate this need. 

 

Note:  The list of users in each document group must also include the user assigned to indexing 

incoming documents. By including this user in each group, the indexer is able to assign incoming 

documents to their respective group. 
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In the screenshot below, “ORL” is entered in the “Document Group Name” field. The Sales Manager 

“Bjones”, the CFO “dogden” and the indexer “tjones” are selected in the “User” list.  Note that each user 

selected receives a check in the box to the left of their name to confirm the selection.  Click “OK” to add 

the new group to the Document Groups and Permissions list.  Clicking “Cancel” will close the “Add 

Document Group” window and the group will not be created. 

 

 

 

The Document Groups and Permissions list will show each group that has been added and displays the 

group “Name” and the names of the “Roles” and “Users” that are members of the group as seen on the 

following page.  “ORL” is listed under “Name” and “Bjones”, “dogden”, and “tjones” are listed under 

“Users”.  These are the only Users that are able to assign Invoices to the “ORL” group or search for 

documents assigned to the “ORL” group. 

 



  ImageQuest Administrator’s Guide 11.0 

70 

 

      

               

To edit a Document Group, double-click the group “Name” or select the group and click “Edit” to open 

the “Edit Document Group” window.  See below.  In this window, you can change the “Document Group 

Name” or add or remove Roles or Users in the group.  
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The “AP/AR” Role is added to the group.   

 

 

 

Once all edits are made, click “OK” to save the changes and update the Document Groups and 

Permissions list as shown below.  Clicking “Cancel” will close the “Edit Document Group” window and 

the changes will not be saved. 
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When a Document Group Name is changed, any documents already assigned to the group will be 

updated to reflect the new Document Group Name.  When Users or Roles are removed from a group, 

they will no longer have access to any documents that are or were assigned to the group. 

To delete a Document Group, highlight the row in the Document Groups and Permissions list and click 

“Delete”.  A “Delete Confirmation” dialogue box will ask to confirm the deletion.  Click “Yes” to delete 

the Document Group or “No” to retain the Document Group.   

 

 

 

A Document Group cannot be deleted if one or more documents are assigned to the group.   If the 

Administrator attempts to delete a group that has documents assigned, an error dialogue box is 

displayed and it includes the number of documents currently assigned to the group.  These documents 

must be edited to change or remove the group assignment before the Document Group can be deleted.   

There is no limit to the number of Document Groups that can be created or Users or Roles that can be 

added to each group.  In addition, the same Users and Roles can be added to multiple Document Groups 

and there is no limit to the number of groups they can be added to. 

Document groups can now be configured as public groups which gives everyone access to the 

documents in that group (assuming the user has document type permissions).   There is also a new 

option to require a document group be selected when indexing a document.  In order to use this 

feature, a default public group must be specified first. 
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Please see the ImageQuest 11.0 User’s Guide for more information on how to add and search for 

documents assigned to Document Groups. 
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Saved Queries 
ImageQuest provides a way for the Administrator to define saved searches that users may use 

frequently.  A list of frequent searches with their corresponding attribute index fields gives users a 

shortcut to locate documents.   

Saved Queries use the Parameterized ImageQuest Query Language (PIQQL), pronounced Pickle, 

developed by Informa Software.  The PIQQL syntax used to execute queries is similar in form to 

Transact-SQL. Specifically, it takes on the same basic structure as the WHERE clause of a Transact-SQL 

query.  However, PIQQL is not designed to be a fully-featured data querying language; its purpose is to 

mimic the search capabilities provided by the IQ end-user applications. This means that PIQQL does not 

support certain features of a native database query language.  In particular, PIQQL does not support 

nested queries, Attribute to Attribute comparisons, or embedded expressions.  A color coded definition 

of the PIQQL query syntax is described below . 

 

Symbol Definition 

Query 

 

Criteria | “(“ Query “)” (“AND” | “OR”) “(” Criteria “)” 

Criteria 

 

Attribute Operator Value | Attribute “IN” “(“ ValueSet “)” 

Attribute 

 

“[“ attribute name “]” 

Operator 

 

“=“ | “<“ | “>“ | “<=“ | “>=“ | “!=“ 

Value “NULL” | NonNullValue | ParameterPrompt 

 

ValueSet NonNullValue | ValueSet “,” NonNullValue 

 

NonNullValue “’“ literal value “’“ 
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ParameterPrompt “’{“ attribute name “:” prompt text “}’” 

 

literal value The actual value of the Attribute, for example an actual invoice number. 

 

attribute name The actual name of the Attribute as defined in IQadministrator 

 

prompt text The text that appears on the client search screen, for example, Enter an 

invoice number. 

 

                                                                                  

In practice, the PIQQL query is simply a string of comparisons of the form [Attribute] = ‘Value’, which can 

be optionally connected by the boolean AND and OR operators. Parenthesis are optional, but can be 

used around any part of an PIQQL query that would itself be a valid standalone query, in order to 

enforce proper grouping of the boolean operations. Literal values that are numeric constants do not 

require the enclosing quotation marks, but they are always valid. (For non-text Attributes, you must 

ensure that the literal value can be converted to the proper type, or the query parser will generate an 

exception.) The one exception to this rule occurs with sets of numeric values within a ValueSet; the 

PIQQL parser currently rejects a ValueSet for an IN statement if the Values are not contained within 

quotations. 

Next to the “Select Query” field, click “New” to create a new query. 
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The screenshot below demonstrates a sample query.  For instance, the attribute “Client ID” is used 

frequently; therefore, a saved query may be helpful to the user to locate documents easily.  The query 

syntax is highlighted and entered as [Client ID] = ‘{?Client ID: Enter the Client ID}’.  Clicking the “Check 

Syntax” button will display the “Parameter Prompt” window.   

 

 

Enter a test string as shown below and then click “OK”. 
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The dialogue box, “Check Syntax,” will inform the Administrator that the query validated successfully as 

noted below. 

 

 

The Administrator is redirected back to the Saved Queries screen as shown on the next page.  Click 

“Save”.   

See below for other syntax examples for creating new queries. 

 

Query Syntax Example Result 

[Employee Number] = '{?Employee Number: Enter an 

Employee Number}' 

 

Prompts the user to enter an employee number 

and searches across all Document Types for that 

value 

 

[DocumentType] IN ('W-4', 'Form I-9') AND  

([Employee Number] = '{?Employee Number: Enter an 

Employee Number}') 

 

Prompts the user to enter an employee number 

and searches only the W-4 and Form I-9 document 

types for that value 

 

                                                         

 

Note:  To execute a Saved Query, see the ImageQuest User’s Guide. 

Note:  Document type names and attribute names are case sensitive in a Saved Query. 
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Document Destruction Rules 
Document Destruction Rules allow the administrator to create rules to destroy any or all ImageQuest 

documents, deleted or not, by Document Type, age and\or custom query.  This feature can be useful for 

organizations that, due to document retention requirements, must destroy certain documents when the 

retention period has terminated. See below. 

 

 

Click “New Rule” to open the Add Document Destruction Rule dialog. 

Type a meaningful name in the “Name” field and select which Document Type(s) apply to the rule.  In 

the “Destroy documents that are older than” section, change the numeric value and select “Days” or 
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“Years” from the drop-down and then select an ImageQuest Date & Time attribute from the drop-down 

list in the “Determine document age using attribute” section. 

 

 

 

For example, the administrator wants to create a new rule to destroy all ImageQuest Employee Records 

where InactiveDate is older than 1 year and Active = “False”.   

The administrator enters “Destroy Inactive Employee Files” for the Name and selects Document Type 

“Employee Record”.  The “Destroy documents that are older than:” value is changed to “1”, “Years” is 

selected from the drop-down and “InactiveDate” is selected from the “Determine document age using 

attribute” section. 

The administrator then clicks “Advanced” to add additional criteria to the rule. 

The Advanced section allows the administrator to add an IQQL (ImageQuest Query Language) query for 

the additional criteria. 
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In the example below, the administrator enters “Active=False” so the rule will only apply to Employee 

Files where the value for attribute Active is False.  After the configuration of the rule is complete, click 

“OK” to save the new rule. 
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The rule will be listed in the General tab and the administrator can click “Details” to view and/or modify 

the rule configuration, “Delete Rule” to delete the rule or “Preview” to preview and perform the actual 

document destruction. 
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In this example, the administrator will run the “Destroy Inactive Employee Files” rule. 

The administrator selects the rule in the list and the selects “Preview”.  A message box will appear 

asking the administrator to confirm they wish to load the preview.  Clicking “Yes” will load the Preview 

Window.  Clicking “No” returns the administrator to the Document Destruction screen. 

For this example, the administrator clicks “Yes”. 

 

The “Preview Documents” window loads and includes the rule name in the title bar.  The example below 

displays 7 documents.  At this point, the administrator has a few different options: 

“Destroy All” will permanently destroy all the documents displayed in the grid.   

“Destroy Selected” will permanently destroy only the documents highlighted (selected) in the grid.   

The “Refresh” button refreshes the current display.  The “Print” button allows the administrator to print 

the grid if needed.  Clicking “x” will close the Preview Documents window.  None of these actions will 

destroy any documents. 

For this example, the administrator will select “Destroy All”. 
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When the administrator selects “Destroy All” or “Destroy Selected”, the message below is displayed.   

 

 

Click “Yes” to continue and perform the operation.   

Click “No” to cancel the operation and return to the Preview Documents window and none of the 

documents will be destroyed. 

For this example, the administrator selects “Yes”. 

When the operation is complete, the Preview Window will display the results.   

The “Destroy All” selection destroyed all 7 documents in the grid, so the Preview Window has 0 

documents to display.  If the administrator had selected 4 of the 7 documents and chose “Destroy 

Selected”, the Preview Window would display the remaining 3 documents once the operation was 

complete. 
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The History tab contains a history entry for each Destroy Deleted Documents operation performed and 

includes the RunDateTime, Rule, Username and Results columns.  The IQQL query used for the 

operation is also displayed.   The administrator can select an entry in the grid to view the details for the 

History entry. 

 

 

Note:  The administrator can preview documents to be destroyed in IQadministrator from any 

machine, but the actual Destroy operation can only be performed from IQadministrator on the 

ImageQuest server. 
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Destroy Deleted Documents 
Prior to ImageQuest version 10.3, documents could only be flagged as Deleted, but this did not remove 

the database record or delete the physical file from disk.  ImageQuest 10.3 introduces two new features:   

Document Destruction Rules and Destroy Deleted Documents, which allow documents and related data 

to be permanently “destroyed”.  When document destruction is performed on a group of documents, 

the documents and document data are physically and permanently destroyed.  Destroyed documents 

can longer be accessed in ImageQuest and also cannot be restored. 

Destroy Deleted Documents allows the administrator to permanently destroy all or certain documents 

that have been flagged as “Deleted” in ImageQuest. 
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The “Choose an option” section allows the administrator to determine which deleted documents can be 

destroyed:  documents created a certain number or Days\Years ago or all deleted documents in the 

ImageQuest system. 

The “Destroy deleted documents that were created… ago.” option is based on the ImageQuest 

“CreateDateTime” system attribute assigned to a document.  The administrator can change the numeric 

value and select “Days” or “Years” so the ImageQuest system will know how far back to search for 

Deleted documents. 

In the example below, the administrator wants to destroy all deleted documents that were created 7 

days ago.  The administrator selects the “Destroy deleted documents that were created… ago” option, 

enters “7” in the numeric field and selects “Days” from the drop-down. 

 
 

The administrator can then click “Preview” to open the “Preview Documents” window to see all the 

documents flagged as deleted that meet the criteria.  The example on the following page displays 7 

documents.  At this point, the administrator has a few different options: 

“Destroy All” will permanently destroy all the documents displayed in the grid.   

“Destroy Selected” will permanently destroy only the documents highlighted (selected) in the grid.  The 

administrator can hold down the CTRL key to select multiple documents.   

The “Refresh” button refreshes the current display.  

The “Print” button allows the administrator to print the grid if needed.   

Clicking “x” will close the Preview Documents window and will not destroy any documents. 
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For this example, the administrator will select “Destroy All”. 

 
 

When the administrator selects “Destroy All” or “Destroy Selected”, the message below is displayed.  

Click “Yes” to continue and perform the operation. 

Click “No” to cancel the operation and return to the Preview Documents window and none of the 

documents will be destroyed. 

For this example, the administrator selects “Yes” to perform the document destruction. 
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When the operation is complete, the Preview Window will display the results.   

The “Destroy All” selection destroyed all 7 documents in the grid, so the Preview Window has 0 

documents to display.  If the administrator had selected 4 of the 7 documents and chose “Destroy 

Selected”, the Preview Window would display the remaining 3 documents once the operation was 

complete. 
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The “Rule execution history” section contains the history of each Destroy Deleted Documents operation 

performed and includes the RunDateTime, Rule, Username and Results columns.  The IQQL query used 

for the operation is also displayed.   The administrator can select an entry in the grid to view the details 

for the History entry. 

 

If “Destroy all deleted document in the system” is selected, the Preview Documents window will display 

every document that is flagged as Deleted in ImageQuest.  The administrator will have the same options 

as shown in the previous examples and the Destroy Deleted Documents operation will be logged in the 

history. 

Note:  The administrator can preview documents to be destroyed in IQadministrator from any 

machine, but the actual Destroy operation can only be performed from IQadministrator on the 

ImageQuest server. 
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OCR Settings 
OCR Settings allows the administrator to enable or disable OCR features and manage the IQ OCR and 

Full Text Service. 

 

To enable or disable Smart Indexing, Fulltext of both, check or uncheck the appropriate box and click 

“Apply”. 

The message below will appear notifying the administrator that the changes will not take effect until the 

current OCR cycle is complete. 

 

 

The Manage Service feature allows the ImageQuest Administrator to confirm the status of the IQ OCR 

and Full Text Service and Stop, Start and Restart the service as needed.  Client machines can also 

manage the service remotely provided their Windows user account has permissions to start and stop 

services on the ImageQuest server. 

The OCR service now benefits from multi-core, hyper-threaded and multi-CPU systems resulting in much 

faster processing times.   

 

 

 

 



  ImageQuest Administrator’s Guide 11.0 

91 

 

There are also two new tabs under the OCR settings menu:  OCR Queue and Fulltext/OCR Errors.  The 

OCR Queue shows the list of documents across all ImageQuest cabinets that are waiting to be both 

Smart Indexed and Full-Text extracted with the document currently being processed highlighted in 

yellow.   

 

Double clicking on a row will launch the application associated with the file type allowing you to view 

the image.   
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The “Fulltext/OCR Errors” tab shows a list of documents that have failed the OCR process for one reason 

or another.  Records in this view can also be double-clicked on to view the failed document.  There is an 

option at the bottom of the window to reprocess the selected documents which may or may not re-OCR 

successfully depending on what the original error message was. 
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Attribute Lookup Configuration  
Attribute Lookup Configuration allows the ImageQuest administrator to configure and manage Attribute 

Lookup settings from IQadministrator.  This was previously configured in the Web.Config file stored in 

the attribute lookup folder of the ImageQuest\WebServices directory.   

Note:  Any lookups that were previously configured before upgrading to version 10.3 will need to be 

reconfigured manually. 
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To create a new lookup, first select an ImageQuest Attribute to be used as the Keyfield.   FirstName is 

selected in the example below.  Click OK to continue and to configure the lookup. 

 

Next, select an ODBC Connection String for the data source from the drop-down.  The list provides some 

commonly used ODBC string templates that may be used.  If you do not see an ODBC Connection string 

for your type of database, one can manually be typed in. 

 

Configure the ODBC Connection String by providing the required parameters for the chosen connection 

string.  Click “Test” to test the connection and confirm it is valid and then click OK to continue. 



  ImageQuest Administrator’s Guide 11.0 

95 

 

Enter the SQL query to be used by the Attribute Lookup to retrieve records from the data source.  Click 

the “Insert Token” button to add the keyfield to the select statement in the proper syntax.  In the 

example below, “[%FirstName%]” is added.  The apostrophes are needed because the keyfield is a text 

value and the extra percent to the right is needed because of the LIKE operator. 

 

The Optional Field Mappings section allows the ImageQuest administrator to map a data source column 

(Source Field Name) to an ImageQuest attribute (Attribute) if the names are not the same. 

 

The Test Input section provides the option to test the Attribute Lookup configuration.  In the example 

below, “j” is entered to lookup any FirstName that begins with the letter j.   Click “Test” to perform the 

lookup. 
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The Attribute Lookup will perform the query on the source and provide a preview of the results.  In this 

example, the lookup by letter “j” returns four unique records.  Click Close to close the results window 

and click “Save” to save the Attribute Lookup Configuration. 
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Notification Rules 
Notification rules allow the ImageQuest administrator to setup an e-mail alert mechanism when a 

specified date attribute falls between today and a fixed number of days in the future, with optional 

recurrences.   Documents that meet this criteria will be placed in the IQ user or role’s Work Queue in 

IQdesktop and an e-mail will be sent to the user(s) with a link to the document in WebIQ. 
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To create a new rule, click the New Rule button.  The following screen shows a sample rule which does 

the following: 

 

• Monitors the attribute called Expiration Date for documents that will expire within 120 days 

from today’s date 

• Sends an e-mail to all members of the Purchasing IQ role with a link to the document in WebIQ 

• A recurring email will be sent to all members of the Purchasing IQ role every 15 days after the 

initial e-mail is sent. 

• The document will be routed to the work queue for all members of the Purchasing IQ role 

• This rule will only be triggered when the Document Type is equal to Contract and the Not 

Renewing True/False attribute is not set to True. 

 

 

 

Note:  Notification Rules will only be triggered when the attribute date is in the future.  The 

notification rule engine processes documents every 60 minutes from the time the IQ application 

service is started. 
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Manage File Storage 
IQadministrator easily allows the Administrator to manage the storage and location of files.  Click 

Manage File Storage to access the Manage File Storage screen as illustrated below. 

Manage File Storage displays the “Status” of the storage location and indicates whether it is Online 

(available) or Offline (not available).  This can be helpful when troubleshooting issues with access to 

ImageQuest documents.   

For the Status to show as “Online” the Storage Location must be accessible from the ImageQuest server 

and the Service Account must have read\write access to the folder. 

 
 

The “Storage location” field shows the current location where the files are stored.  The “Total items” 

value shows the total number of files in the “Images” folder; the “Refresh” button allows the 

Administrator to update the “Total items” count.  To change the “Storage location”, click the “Change” 

button as illustrated below.   
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Note:  The storage location is exclusive to ImageQuest, with its own folder structure, and should not 

be modified in any way. 

The “ImageQuest Storage Provider Update Wizard” guides the Administrator through the process of 

changing the file storage location.  Read the highlighted notes carefully and click “Next” to proceed. 

 

The “Current Root” field, highlighted below, shows the current location of the IQ files.  To change the 

folder, either type in the new path or click “Browse” to choose a new root file path. 
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Enter the new root folder in the “New Root” field as displayed below. Click “Next” to proceed.  As you 

proceed, the “Update Wizard” will check for files which are missing from the new root path if “Skip 

checking for missing files” remains unchecked; this process may take several minutes depending on the 

size of your document storage.  To bypass this check, click the “Skip checking for missing files” box.  Click 

“Next”. 

                               

The “ImageQuest Storage Provider Update Wizard” screen prompts the Administrator to update the 

new file storage root.  Click “Finish” to complete this operation as shown below. 
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The Manage File Storage screen below now displays the new “Storage location”. 

 

 

Note:  The “Storage Provider Update Wizard” does NOT move any files; it simply allows the 

Administrator to redirect the physical image storage location for new documents.  The Administrator 

must manually move the existing root folder to the new storage location.   
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Configure IQfolder 
IQfolder is a service that runs on the IQ Server to poll user defined folders for .tif files making them 

accessible from the Indexing Queue in IQdesktop.   

Note:  .TIF files should be saved as multi-page .TIF files in order for the scan to show up as a single 

document in the Indexing Queue.   

The first configuration step is to create the folder locations where scanned .TIF images will be saved. 

IQfolder supports an unlimited amount of folders. 

Configure the folder location path in IQadministrator; select Configure IQfolder as shown below.  Read 

the highlighted notes in the window for more information. 
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Then click the “Browse”  button to add a folder or to browse to an existing folder.  

 

 

 

 

 

 

Click to choose the user from the drop-down menu in the user column.  To save changes to a row, tab to 

the next row.  The Administrator can also assign a role to a folder as demonstrated in Figure 8.2.  This 

will cause the scanned files to appear in the “Indexing Queue” for every member of that role.  Only one 

user can access and index the file at one time.  Once a member of the role has indexed the file, it will no 

longer appear in the other member’s “Indexing Queue”. 
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The Manage Service feature allows the ImageQuest Administrator to confirm the status of the IQfolder 

Image Importing Service and to Stop, Start and Restart the service as needed.    Client machines can also 

manage the service remotely provided their Windows user account has permissions to start and stop 

services on the ImageQuest server. 

 
 

Note:  In addition to browsing for folders, a folder path can be typed or pasted. 

Note:  The folder locations are relative to the server where the IQ folder service is installed. 

Note:  A folder can be assigned to either a User or Role; it cannot be assigned to both. 

Note:  Refer to the scanner user’s guide for more information on configuring the device to scan and 

save .TIF images to folders. 

Note:  It is recommended to scan Black & White (B & W) images at 300 dpi, and color images at 150 

dpi. 

Note:  To delete a row with a saved folder location, highlight the row and press the keys Ctrl+D. 
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Configure IQmfp (OXPd) 
“Configure IQmfp (OXPd)”, which was introduced in IQ v10.3, is the method for adding and managing 

ImageQuest on supported HP MFP Devices.  ALL HP MFPs MUST BE UPGRADED to OXPd in order to 

work with ImageQuest version 10.3 or higher.  

Before adding a new device, the OXPd Solution Installer must be installed on the device. 

Confirm Device Model Number and Firmware Versions 

Before installing OXPd, confirm the HP device supports OXPd and it is running at least the minimum 

firmware version required.  The list below displays the supported devices and minimum required 

firmware versions. 

MINIMUM MEMORY & FIRMWARE VERSIONS SUPPORTED: 

------------------------------------------------------------------------------- 

 

The devices covered in this release include the following models: 

 

• LJ M3035mfp series:  256MB, 48.101.4 

• CLJ CM3530mfp series:  512MB, 53.031.4 

• LJ 4345mfp series:  256MB, 09.151.3 

• LJ M4345mfp series:  256MB, 48.101.4 

• LJ M4349mfp series:  256MB, 48.101.4 

• CLJ 4730mfp series:  256MB, 46.231.3 

• CLJ CM4730mfp series:  384MB, 50.081.3 

• LJ M5035mfp series:  256MB, 48.101.4 

• CLJ CM6030mfp series:  512MB, 52.051.3 

• CLJ CM6040mfp series:  512MB, 52.051.3 

• CLJ CM6049mfp series:  512MB, 52.051.3 

• LJ 9040mfp series:  256MB, 08.141.3 

• LJ 9050mfp series:  256MB, 08.141.3 

• LJ M9040mfp series:   384MB, 51.051.4 

• LJ M9050mfp series:  384MB, 51.051.4 

• LJ M9059mfp series:   384MB, 51.051.4 

• DS 9200C:   256MB, 09.151.3 

• DS 9250C:    256MB, 48.091.3 

• CLJ 9500mfp series:  512MB, 08.141.3 

• SJ 7000n:   Natively Supported 

• M4500 series:   Natively Supported 

 

HP device firmware version can be retrieved from the device configuration page.  

HP device firmware can be downloaded from http://www.hp.com. 
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Loading the OXPd Solutions Installer onto the device 

Browse to http://<deviceIPaddress>/hp/device/this.loader from the ImageQuest server to access the HP 

device Package Loader page.  You will need to provide the device admin credentials to access the page. 

Click the “Browse” of “Choose File” button and locate the OXPd Solution Installer jar file. This jar file is 

located in the Informa Software application directory on the ImageQuest Server. 
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For example, if the ImageQuest Server was installed to C:\Program Files(x86)\Informa Software, the 

OXPd Solution Installer jar file would be located in C:\Program Files(x86)\Informa 

Software\ImageQuest\OXPd\SolutionInstaller. 

Select hp_oxpdsolutioninstaller-ex-1.0.1.0.jar and click “Open” as shown in the example below. 
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Click “Load Package Now” to load the jar file.  It may take a few minutes to load. 
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The Package Loader page will confirm the jar file was loaded successfully. 

Close the device Package Loader page. 
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Configure IIS for OXPd 

Internet Information Services (IIS) must be installed and configured for OXPd. 

Open Internet Information Services (IIS) Manager on the ImageQuest server, expand Sites and right-click 

Default Web Site and select “Add Virtual Directory”. 
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In the Add Virtual Directory dialog, type “OXPd” for the Alias and browse to and use the Informa 

Software\ImageQuest\OXPd directory on the ImageQuest Server for the Physical path. 

 
 

Click “OK” to close to save and add the new OXPd Virtual Directory. 
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Confirm “Anonymous Authentication” is “Enabled” for the OXPd Virtual Directory by selecting OXPd and 

double-clicking “Authentication” to view the Status.  

 
 

If “Disabled”, right-click Anonymous Authentication and select “Enable”. 
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Install OXPd on the device 

Open the following in a browser:  http://<imagequestservername>/OXPd/oxpdsolutioninstaller.html to 

load the OXPd SolutionInstaller page.  Do not use “localhost” for the ImageQuest Server name. 
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Enter the device IP address in the “Device IP Address” field, select either http or https for “Protocol” and 

select the HP device model number from the “Device Model” drop-down. 

In the example below, “192.168.200.69” is used for Device IP Address, Protocol is “http” and the 

“M5035” is selected from the Device Model drop-down. 
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For Step 1, click “Browse” to locate the ChaiSOE_DSE Package manifest.  This manifest is located in the 

Informa Software application directory on the ImageQuest Server. 

There are three different ChaiSOE_DSE Package manifests available, DSE10, DSE20, or DSE30.  When a 

Device Model is selected, the OXPd SolutionInstaller page will display the folder path above the 

“Manifest” field and includes the proper DSE folder for the selected device model.  In the example 

below, the sample path is “C:\Program Files\Informa Software\ImageQuest\OXPd\DSE20\manifest.xml”. 

 

 
Browse to the proper file folder on the ImageQuest Server and click “Open” to select the manifest. 
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Click “InstallApp” to install the ChaiSOE_DSE package manifest.  You may need to provide the HP device 

admin credentials to proceed. 

 

 
 

The Reply box will display “202 Accepted” if the file upload was successful. 
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Verify the ChaiSOE_DSE Package manifest loaded successfully by clicking the “ListApps” button above 

the Reply field and confirm the “loadStatus” for the ChaiSOE_DSE “appURL” is “Loaded”. 
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For Step 2, click “Browse” to locate the OXPdWorkflow Package manifest.  This manifest is located in the 

Informa Software application directory on the ImageQuest Server. 

There are three different OXPdWorkflow Package manifests available, OXPdWorkflow10, 

OXPdWorkflow20 or OXPdWorkflow40. When a Device Model is selected, the OXPd SolutionInstaller 

page will display the folder path above the “Manifest” field and includes the proper OXPdWorkflow 

folder for the selected device model.  In the example below, the sample path is “C:\Program 

Files\Informa Software\ImageQuest\OXPd\ OXPdWorkflow20\manifest.xml”. 

 

 
Browse to the proper file folder on the ImageQuest Server and click “Open” to select the manifest. 
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Click “InstallApp” to install the OXPdWorkflow Package manifest. 

 

 
The Reply box will display “202 Accepted” if the file upload was successful . 
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Verify the OXPdWorkflow Package manifest loaded successfully by clicking the “ListApps” button above 

the Reply field and confirm the “loadStatus” for the OXPdWorkflow20 “appURL” is “Loaded”. 
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To confirm OXPd was successfully loaded onto the device, log into the device Embedded Web Server 

(EWS) click the “Digital Sending” tab and verify “OXPd:Workflow” is listed in the settings menu.  Select 

“OXPd:Workflow” to view the current settings. 
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The device is now ready to be added to ImageQuest using Configure IQmfp (OXPd) in IQadministrator.  

Please make sure your device is licensed prior to adding it to ImageQuest. 
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Click “New” to add a new device.  The IQ Server field will be populated with the ImageQuest server 

information. 

Enter the Display Name and Host Name/IP Address for the new device.  In the example below, “M5035” 

is used for Display Name and IP address “192.168.200.69” is used for Hostname/Address.  Press the Tab 

key to connect to the Mfp device. 
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If the connection is successful, the MFP device Model Name and Serial Number will be populated as 

shown below.   

The administrator can then select the default settings for Page Orientation, Color, Page Size and Number 

of Sides. 
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The “Device Users” section allows the administrator to determine which ImageQuest users or role users 

will be added to the user list on the device.  Check “All Users” if all ImageQuest users should be added.  

Uncheck “All Users” to activate and select from the “Users in Role” drop-down. 
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Click “Save” to add IQmfp to the Mfp device front panel.  You will be prompted to provide the device 

administrator credentials before the process can complete. 

 

 
 

The following message confirms the device was added successfully. 
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Advanced Configuration 

 

This section covers administrative topics that fall outside of IQadministrator.  The following topics are 

discussed below in further detail: 

• Microsoft Windows Services 

• Database Configuration Utility 

• Report View 

• WebIQ 

• Log Files 

Microsoft Windows Services 
The ImageQuest installation creates the following three Windows services that run in the background on 

the IQ Server: 

• “IQ Application Service” 

• “IQ OCR and Full Text Service” 

• “IQfolder Image Importing Service” 

 

The “IQ Application Service” is required for the client applications to connect to the IQ Server.  If this 

service is not running, all IQ client applications will fail to launch.  The other two services depend on this 

service as well and will stop if it’s not running.  There is nothing to configure with this service. 

The “IQ OCR and Full Text Service” is responsible for performing “IQ Smart Indexing” OCR on .TIF files in 

the Indexing Queue to allow quick “click and drag” indexing in the document Indexer.  It is also 

responsible for extracting text from indexed documents and storing it in the database for keyword 

searching.  In the case of indexed .TIF files, the file is converted to a searchable PDF after the OCR 

process is complete.  Other common file types submitted using the other IQ client applications may be 

text extracted as well to allow for keyword searching, but the file type is not converted and remains in 

its native format.  This service is dependent on the “IQ Application Service”; there is nothing to configure 

for this service. 

The “IQfolder Image Importing Service” polls all of the folders setup in IQadministrator at 60 second 

intervals and moves .tif files into the Indexing Queue in IQdesktop as an MFP Scan document type.   This 

service is dependent on the “IQ Application Service”.  By default, IQfolder is configured to look at folders 

on the IQ Server only.  If folders are created on a network share, the IQfolder service will need to be 

configured with domain credentials.   
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To configure the service, open the Microsoft Windows Services application; go to Start > Control Panel > 

Administrative Tools > Services.  Locate and double-click the IQfolder Image Importing Service as shown 

below and on the following page.   
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Click the “Log On” tab, select “This account” and enter a username and a password.  The user specified 

here must have access to read and modify ALL folders created in IQfolder.  Click “OK”.   

 

 

Restart the IQfolder service in order for the changes to take effect. 

Note:  If the IQfolder service is unable to delete a .TIF file from the directory, the service will be 

stopped and an entry will be logged to the IQfolder service log file (see section for Logfiles).                                           
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Database Configuration Utility 
There is a new configuration tool included on the ImageQuest server that allows the administrator to 

update the SQL server credentials.  This can be used if the ImageQuest database is moved to another 

SQL server or if the SQL login credentials have changed.  The password is no longer stored in the 

webservices\web.config file and it is now encrypted. 

 

 

 

 

 

 

 

 

 

 

Note:  The ImageQuest Application Service must be restarted after making a change to the database 

credentials. 

Report View 
Report View is a program that administrators can run from the ImageQuest server that creates a SQL 

view called vwMetadata within the ImageQuest database that can be used for reporting purposes.  The 

program exposes the ImageQuest data in an easy to use format and must be run whenever attributes 

are added or removed from the system.  It creates views for all of the cabinets in the warehouse and can 

be found in the ImageQuest client installation folder using Windows Explorer: 

..\ImageQuest\ClientTools\Administrator\Informa.ImageQuest.ReportView.exe 

Note:  Report View can only be run from the ImageQuest server console and a valid reporting license 

must be installed.  
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WebIQ 
WebIQ can be setup after the ImageQuest server installation and it requires Internet Information 

Services (IIS) be installed on the ImageQuest server for configuration. 

Configure WebIQ in IIS on Server 2003 or Windows XP 

To configure WebIQ for IIS 6.0, please follow these steps: 

1) Open Control Panel >Administrative Tools >Internet Information Services (IIS) Manager 

2) Expand the server name tree 

3) Expand Web Sites 

4) Right click on Default Web Site and select New>Virtual Directory and click “Next” 

5) Enter “WebIQ” for the Alias and click “Next” 

6) Browse to the following path: C:\Program Files\Informa Software\ImageQuest\WebIQ and click 

“OK” and “Next” 

7) Check “Read” and “Run scripts (such as ASP)”  to allow the permissions  and click “Next”. 

8) Click “Finish”.  WebIQ should now be listed under Default Web Site 

9) Right click on WebIQ and choose “Properties” 

10) Select the “Directory Security” tab 

11) Click “Edit” in the Authentication and access control section 

12) Uncheck “Anonymous Access” and check “Integrated Windows Authentication” 

13) Click “OK” and “OK” again to close out of IIS 

14) Restart IIS 

15) If a firewall is enabled on the IQ server, make sure port 80 is open 

16) Browse to http://servername/webiq/default.aspx and confirm the WebIQ homepage is 

accessible 

 

Note:  ASP.NET  v4.0.30319 may need to be set to Allowed under Web Service Extensions. 
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Configure WebIQ in IIS on Server 2008/2008 R2 or Windows Vista/7 

Before configuring WebIQ in IIS 7, please confirm the following IIS features have been installed: 

 

Common HTTP Features 

      

- Static Content 

- Default Document 

- Directory Browsing 

- HTTP Errors 

 

Application Development 

      

- ASP.NET 

- .NET Extensibility 

- ISAPI Extensions 

- ISAPI Filters 

 

Health and Diagnostics 

      

- HTTP Logging 

- Request Monitor 

 

Security 

 

- Windows Authentication 

- Request Filtering 

 

Performance 

 

- Static Content Filtering 

 

Management Tools 

 

- IIS Management Console 

- IIS 6 Management Compatibility 

- IIS 6 Metabase Compatibility 

- IIS 6 WMI Compatibility 

- IIS 6 Scripting Tools 

- IIS 6 Management Console 
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To configure WebIQ for IIS 7.0, please follow these steps: 

1) Open Control Panel>Administrative Tools>Internet Information Services (IIS) Manager 

2) Expand the server name tree 

3) Expand Sites 

4) Right click on Default Web Site and select “Add Application” 

5) In the Alias box, type "WebIQ" 

6) Click "Select" to change the Application pool to "Classic .NET AppPool" and click “OK” 

7) Click the elipses next to the "Physical path" box and browse to C:\Program 

Files\InformaSoftware\ImageQuest\WebIQ and click “OK”.  WebIQ should now be listed under 

Default Website 

8) Select WebIQ 

9) In the WebIQ Home section on the right, double click "Authentication" 

10) Make sure that "Anonymous Authentication" is Disabled (if on a workgroup environment, leave 

this Enabled) 

11) Enable "ASP.Net Impersonation", "Forms Authentication: and "Windows Authentication" 

12) Restart IIS 

13) If a firewall is enabled on the IQ server, make sure port 80 is open 

14) Browse to http://servername/webiq/default.aspx and confirm the WebIQ homepage is 

accessible 

Note:  ASP.NET  v4.0.30319 (32 bit) may need to be set to Allowed under ISAPI and CGI Restrictions. 

 

Additional configuration for WebIQ on a x64 bit Operating System 

To enable WebIQ to work in a x64 environment, 32-bit mode must be enabled. To run the 32-bit version 

of ASP.Net  4.0, follow these steps: 

1. Click Start, Run, type CMD and then click OK 

2. Type the following command to enable the 32-bit mode: 

 

cscript %SYSTEMDRIVE%\inetpub\adminscripts\adsutil.vbs SET 

W3SVC/AppPools/Enable32bitAppOnWin64 1 

 

Note:  The value of %SYSTEMDRIVE% for the above command in most cases is C:. 

 

3. Type the following command to install the version of ASP.NET 4.0 (32-bit) and to install the 

script maps at the IIS root and under: 

 

%SYSTEMROOT%\Microsoft.NET\Framework64\v4.0.30319/aspnet_regiis.exe –i 

 

Note:  The value of %SYSTEMROOT% is the location of the system folder, including the drive and path. 

 

4. Make sure that the status of ASP.Net version 4.0.30319 (32-bit) is set to “Allowed” in the Web 

Service Extensions or ISAPI and CGI Restrictions in IIS Manager. 
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Log Files 
By default, the IQ service logs (IQ Application, IQFolder, IQocr, ServiceHost, etc) and Add-on logs are 

located here on the IQ Server : C:\WINDOWS\Temp\Informa Software\Logfiles. 

 

 

 

The IQ client logs are stored in the following location on the client machines:  %temp%\Informa 

Software\LogFiles.  

 

 

 

Note:  The Local Settings folder is a protected operating system folder and is hidden by default. 
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